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Microsoft Excel has been around for decades and many have used it since its release. But
there are still others who are just now starting to use it. Whether for work, school, or personal
use, it can be a little intimidating when you first begin. There are even classes for new Excel
users both online and on campuses.

This guide to Excel is for those who have never used it before, are struggling with itas a
beginner, or just want the basics to then learn it on their own.

What Is Microsoft Excel?

In the simplest of terms, Excel is a spreadsheet application. It uses grids of cells within columns
and rows to manipulate, organize, and perform calculations with data. You can use pivot tables,
charts, formulas, and functions in a variety of ways.
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That being said, the application is not limited to numbers, although that’s where it “excels.” You
can add text, images, videos, objects, and many other items to help track, manage, and easily
view information.
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General Uses for Excel

- Budgets for household or business finances

- Invoices and receipts

- Tracking for projects, client and customers, and health records
- Planners and calendars

- Checklists and task lists

- Financial, loan, debt, and mortgage calculations

- Inventory management

The list goes on with the many uses for Excel. So, whatever you plan to use it for, let’s look at a
few of the terms you will need to know.

Basic Excel Terms You Should Know

Throughout this guide, you will see the same terms used again and again. Getting familiar with
them will help you to understand the guide and the steps you see.

Workbook and Spreadsheet: A workbook is what you actually use when you open Excel. The
workbook contains the spreadsheets. A workbook can hold many spreadsheets and you
can move between those sheets with the tabs on the bottom of the Excel workbook.

Cell: Spreadsheets are made up of rectangular blocks called cells. A cell contains the data you
enter; from numbers to words to images to formulas, cells hold that information. You can enter
data either directly in the cell or in the formula bar (text box) for the cell right below your
ribbon.

You will also notice the name box (cell indicator) to the left of the formula bar. By default, this
displays the corresponding column and row for the cell. For instance, the cell in the top left
corner of the spreadsheet is Al for column A, row 1.

Formulas and Functions: You can think of a formula as a calculation or equation. With Excel,
you can create formulas or use built-in ones. These formulas can automatically calculate
numbers for you like addition or multiplication.

In addition to calculations, you can use functions for things like counting the number of items
in a column or displaying a minimum or maximum number for a group of cells.
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The Excel Tabs and Ribbon

You should take a little time to familiarize yourself with the ribbon in Excel. Just like with other
Microsoft Office applications, the ribbon holds the buttons that you will use inside tabs. You
can customize the ribbon to remove or add both tabs and buttons. But you will likely see the
tabs below by default.

Home tab
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Here is a brief explanation of what each one is for and which button sections you can see.

- File: Create a new workbook, open an existing one, save, print, and share books and
sheets.

- Home: Ctrl the clipboard, font, alighment, numbers, style, cells, and editing.

- Insert: Insert tables, charts, illustrations, filters, and links.

- Draw: Use drawing tools such as a lasso selection, eraser, pen, and highlighter.

- Page Layout: Adjust the spreadsheet theme, page setup, scale-to-fit, and sheet options.

- Formulas: Pick a formula, function from the library, and perform formula auditing.

- Data: Get and transform data, view queries and connections, sort, filter, and use data tools.
- Review: Use tools for proofreading, accessibility, language, and comments.

- View: Change the workbook view, items to show, zoom in or out, and work with windows.

Also, note the Tell me what you want to do box. If you need help or want more informationon a
feature, just enter the keyword into the box and view your results.
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The Quick Access Toolbar

As with the tabs and ribbon, if you use other Microsoft Office applications you should be
familiar with the Quick Access Toolbar. But if not, this is the toolbar at the very top left of the
Excel window. And it is important because it allows you to quickly undo or redo an action, plus
save your file.
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If you make a mistake and want to undo it, just click the Undo button. If you click it once, it will
undo the last action you took. If you keep clicking it, it will undo actions you took one-by-one
moving backward. Alternatively, you can click the arrow next to the Undo button and highlight
all actions you want to undo.

If you undo an action with the button, the Redo button will then be clickable. This lets you redo
what you have just undone. Like the Undo button, you can redo your last action with one click
or use the arrow next to the Redo button to redo multiple actions.

The Save button lets you quickly save the file you are working on with the current file name.
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Spreadsheet Options
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Managing a large number of spreadsheets is no problem for Excel. So, you can use more than
one if your project calls for it. For example, you can use different spreadsheets for months or
years, product warehouse locations, loan or credit card companies, and healthcare facilities.

[ create a copy

Along with multiple sheets, you can take advantage of these basic spreadsheet features.
- Add a spreadsheet: Click the plus button at the bottom next to your last sheet.
- Rearrange spreadsheets: Hold the sheet tab and drag to its new spot in the workbook.

- Name a spreadsheet: Double-click the sheet tab and type the new name. By default, you
will see them named Sheet 1, Sheet 2, and so on.

- Color a spreadsheet tab: Right-click the sheet tab and under Tab Color, just click to apply
anew one.

- Protect a spreadsheet: Right-click the sheet tab and under Protect Sheet, add a
password and select your options.

- Move or copy a spreadsheet: Right-click the sheet tab and select Move or Copy. You can
then move the sheet to another spot in the workbook, move it to a different workbook,
and make a copy of it for either case.

- Delete a spreadsheet: Right-click the sheet tab and click Delete. You will need to confirm
this action in the subsequent pop-up window.
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Working With Columns, Rows, and Cells in Excel

There are some basics such as selecting, inserting, deleting the columns, rows, and cells in
Excel. These are handy actions to keep in mind as you work with your spreadsheets.

Select an Entire Column or Row

You will notice as you move your mouse over the letters for the columns or numbers for the
rows that a small arrow will appear. If you click at that time, the entire column or row will be
selected. You might use this action for applying a function, formatting, or sorting.

A B C D I

1 Item Number Product Name Price
2 47715|iPhone Case S23
3 47716|iPad Case S33
4 47717|Galaxy Phone Case S20
5 47718|iPhone Screen Protector $10
6 47719|iPad Screen Protector S12
7 47720|Galaxy Phone Screen Protector|S10
8

9

10

11

Select a Group of Columns, Rows, or Cells

There may be times when you want to select more than one column, row, or cell. You can do
this in a couple of different ways depending on if they are adjacent or scattered.

Select Adjacent Columns, Rows, or Cells

When you want to select columns, rows, or cells that are next to each other, begin by selecting
the first one. Then, hold down your mouse button and drag through the rest. You will see them
highlight as they are selected. Release the mouse button when you finish.
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Another way to do this is to select the first one, hold down your Shift key, and then select the
last one. If you do this with cells, you can select an entire group across and down.
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B G
[tem Number Product Name Price
47715 iPhone Case S23
47716 iPad Case S33

47717 Galaxy Phone Case $20
47718 iPhone Screen Prot $S10
47719 iPad Screen Protect $12
47720 Galaxy Phone Scree$10

Select Scattered Columns, Rows, or Cells

If you would like to select columns, rows, or cells that are not adjacent, start by clicking the first
one. Then, hold down the Ctrl key and continue clicking the ones you want. Release
the Ctrl key when you finish.
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47718 iPhone Screen Prot S10
47719 iPad Screen Protect$12
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Insert or Delete a Column, Row, or Cell

'Price
S23
S33

You can easily add or get rid of a column or row that you no longer need. Again, put your mouse
over the letter or number, but instead of left-clicking your mouse, right-click. In the context
menu that appears, select either Insert or Delete.

A B C
1 Item Number| Product Name X
2 47715|iPhone Case B
3 47716|iPad Case
4 47717|Galaxy Phone Cat¢
5 47718|iPhone Screen Pri
6 47719|iPad Screen Prote
7 47720|Galaxy Phone Scr
8
9 —
10 -
11
12
13

D
Cut

Copy

Paste Options:

Insert
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Clear Contents
Format Cells...
Column Width...
Hide

Unhide
1

You can also simply hide (and unhide) columns or rows by selecting Hide (or Unhide) from the

context menu.

You can insert or delete a cell the same way as a column or row. However, with either option,
you will receive a pop-up alert asking how you would like to shift the cells, row, or column. Just

choose an option and click OK.
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Move a Column, Row, or Cell

If you decide to move a column, row, or cell to a different spot in your spreadsheet, you can do
it but must be careful. First, select the column, row, or cell as described above. Put your mouse
over one of the edges of it so that the four-sided arrow appears. Then, drag it by holding down
your mouse button to its new location and release.

B 1 C 1 D | E | F
%cem Number Product Name Price
47715 iPhone Case S23
47716 iPad Case $33

47717 Galaxy Phone Case $20
47718 iPhone Screen Prot S10
47719 iPad Screen Protect $12
47720 Galaxy Phone Scree$10
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What you must be cautious of is if you release the column, row, or cell over the top of one that
already contains data. If this happens, a pop-up box will appear asking if you are sure you want
to replace the data. So, if you do this in error, click Cancel and it will go back to its original spot.
But if it’s your intent to replace the data, click OK.

Microsoft Excel X

| There's already data here. Do you want to replace it?

oK Cancel

Adjusting the Size of a Column or Row

You may want all or some of the columns or rows on your spreadsheet to be a specific size
regardless of the data they hold. Adjusting the width or height is simple and can be done in two
different ways.

First, you select and right-click the column or row. In the context menu choose either Column
Width or Row Height, depending on which one you want to change. In the pop-up window that
appears, you will see the current width or height. Replace it with the number you want and
click OK.
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477 = ¥ $23
P Opti -
477 aste Options $33
477 ase S20
477 'rot $10
477 Insert tectS12 | Column Width ? X
477 Delete sreeS10 a1 T
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=] Format Cells...
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Another way to adjust the size of a column or row is to first select it. Move your mouse to the
border until you see a two-sided arrow appear. Then, hold down your mouse button and drag
until you reach the size you want.
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Adjusting the Size to Fit Your Data

If you would rather have each column and row sized to accommodate your data, you can do
this in ajust a few clicks. First, select the entire spreadsheet by clicking the triangle in the
upper left corner between the A and the 1.

Then, move your mouse between two columns until you see the two-sided arrow and double-
click. Next, do the same for the rows. You will notice both columns and rows of the spreadsheet
adjust to fit the data in your cells. It will automatically adjust for the cell with the longest
amount of data.
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Basic Formatting

Excel offers a variety of ways to format your spreadsheets, from basic to advanced. Since this
is a beginner’s guide, we will go through some simple formatting tips that you would likely use.

Fonts, Shading, and Colors

Home Insert Draw Page Layout Formulas Data Review View ¢ Tell me what you wz

X, Cut . -« ~ N o,

i Calibr 11 - A A - ¥ Wrap Text General

3 Copy ~ —

o FormatPointer | B I U ° - QA = € 3= [ Merge&Center ~ $ -~ %

Clipboard Font Alignment . Number
C20
A B C D E

1
2 47715 iPhone Case S23
3 47716 iPad Case $33
4 47717 Galaxy Phone Case S20
5 47718 iPhone Screen Protector S10
6 47719 iPad Screen Protector $12
7 47720 Galaxy Phone Screen Protector $10
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No matter what you decide to use Excel for, basic formatting of columns, rows, and cells can
help you view your data easily. For instance, you may use the first row of a spreadsheet to
insert headers. Like in our example for a product sheet, you might use item number, product
name, and price.

To make that top row stand out better from a large amount of data beneath, you can format it
easily. Select the row and then apply your formatting using options on the Hometab. Here, you
may make the font bold, apply a fill shade, and color the font.

1. Select the top row.

2. Click the Bold

3. Click the arrow next to the Fill Color and pick a color.
4. Click the arrow next to the Font Color and pick a color.

Keep in mind that these instructions will apply to the entire first row. If you only have a few
columns, you can follow the steps further above to only select certain cells in that row and
apply the formatting to them alone.
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Dates, Currency, and Decimals

If you are creating a tracking spreadsheet, automatic formatting for dates, currency, and
decimals is convenient. And you can apply each of these formatting rules in just a few clicks
from the Home tab.

Dates
B0 R ) e= Bx fon (2 A p
| 5 s B DY & & K ¥~ ¥
ABC General 1al Formatas Cell  Insert Delete Format _  Sort & Find &
123 No specific format g- Table ~ StYIeS = ~ = - Filter ~ Select
12 - Styles Cells Editing
[ e | Currency
G H |

¢ == Accounting ;e Short Date Long Date
/ 2/14/2018 Wednesday, February 14, 2018

fe===  Short Date 4

(
r '—.' Long Date )

You may have a Date column on your spreadsheet for many reasons. When you enter the data,
when you make a purchase, or when an item is due are all just examples.

1. Select the column, row, or cell where you will enter the date.
2. Under Number on your ribbon, click the arrow in the General
3. Select either Short Date or Long Date from the dropdown box.

Note that if you use the Long Date, which inserts words and numbers as shown below, you do
not have to type it in manually. For instance, if you apply a Long Date and enter “2/14/18” it will
automatically populate as “Wednesday, February 14, 2018.”
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Currency
Method One Method Two
| |
= G 1 r
ABC General al enera {E3
123 No specific format g7 $ -~ % 9 €0 W I_Conditignal
12 Number $ Englf&h (United States)
£ English (United Kingdom)
t e | Currency
G € Euro (€ 123)

I: Accounting e ¥ Chinese (PRC)

¢ ! CHF French (Switzerland)

» [Ta] ShortDate ) More Accounting Formats...

A( )

If you have a spreadsheet for your budget, price list, or invoicing, then you can apply the
currency format easily in two different ways.

Method One
1. Select the column, row, or cell where you will enter the currency.
2. Under Number on your ribbon, click the arrow in the General
3. Select Currency from the dropdown box.
Method Two
The second method allows you to choose the type of currency you would like.
1. Select the column, row, or cell where you will enter the currency.
2. Under Number on your ribbon, click the arrow next to the Currency
3. Select the type of currency you wish to apply.

Whichever method you decide to use, any number that you enter into the applied columns,
rows, or cells will automatically be formatted as that currency.
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Decimals
- 11 A== =¢ General - D
u-|=- &-A- = == & 3= , $-%, €0 00 ConditignalFormat
Formatting - Table
Font s Alignment ¥ Number p Styles
Jx
E_ | F | G | H | J K L
Grade Currency
2.5 S 1
4.0 S 2
3.8 S 3
4.0 S <
1.3 S 5
2.5 S 10

You can use the decimal formatting to adjust your currency or simple numbers. For instance,
you may be tracking your student’s grades or even your own where you need decimals. You
can apply this formatting with these two steps.

1. Select the column, row, or cell where you will enter the number.

2. Under Number on your ribbon, click either the Increase Decimal or Decrease Decimal
button depending on your current numbering format.

Copyright © 2018 MakeUseOf. All Rights Reserved ®.



Additional Number Formats
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More Number Formats...

You will also notice under Number on your Home tab, many additional ways to format your
numbers. As you progress with Excel, these may come in handy.

These options include times, fractions, percentages, and others. Plus, you can click the More
number formats link at the bottom to see options like ZIP code, phone number, and custom
choices.

Simple Formulas: The AutoSum Tool

One of the best time-saving features in Excel is the AutoSum tool. It’s easy to use and can
help reduce calculation errors. And if you are using Excel for a project like income and
expenses or loan and debt management, you will appreciate the AutoSum feature.

This uncomplicated formula tool can add, average, count numbers, or find the minimum or
maximum for a column, row, or group of cells. By default, you should see the AutoSum button
on your Home tab ribbon, all the way to the right. You can also access it from the Formulas tab.
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If you just click the AutoSum button, it will automatically insert the sum function. But if you
click the arrow for the button, you will see the other common formulas you can use mentioned
above.

Say that you have a column of numbers you would like to add. First, click the cell where you
would like the total to display. Next, click the AutoSum button. Excel will automatically detect
the numbers you want to add. They will be highlighted and you can see the formula which may
appear something like this: =SUM(C2:C7)

Note: The equal sign indicates a formula. SUM is the function. And C2:C7 are the cells that
apply.

If this looks correct for you, just hit your Enter key. The calculation will pop into the cell adding
those numbers for you.

2 e > B ERB-CBR QO =
AutoSum Recently Financial Logical Text Date & loockup & Math&  More
Used ~ . . = Time = Reference = Trg ~ Functions = AutoSum Recently Financial Llogical Text Date & Llookup & Math&  More
IR Used ~ v - - Tine ~ Reference ~ Trig ~ Functions ~
Funcion Lrary
f . x v fe SUM(C2:C7) .
fe SUM(C2:C7)
A B C D |
——————————1 A ] C D E
» Number Product Name Price ———
greeeeeeeee e t y Number Product Name Price
47715 iPhone Case 1523 { 47715 Phone C $23
47716 iPad Case 1533 ! 476 lv dC . $33
Pa ase
47717 Galaxy Phone Case 1520 {
i N - B ! 47717 Galaxy Phone Case $20
] one reen Frotector
47719 iPad S¢ Protect :Sn ! 47718 iPhone Screen Protector $10
& reen Protector
47;1()'(, : :ho ~ —— :sxo E 47719 iPad Screen Protector $12
ne n n
alaxy e creen Protector 3510 . ... 47720 Galaxy Phone Screen Protector  $10
[=sum@2cn | >
! = — - $108
' number! Der 1

The other options within AutoSum work similarly. Maybe you need to get the average of a
group of cells. First, click the cell where you want the average to display. Next, click the arrow
for the AutoSum button. Again, Excel will automatically detect the numbers, highlight the cells,
and provide the formula. Click the Enter key to insert the average.
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As we mentioned in the Basic Terms for Excel section, there are many formulas and functions
that you can use. Some, like AutoSum, provide very simple and commonly-used calculations.
But many others are advanced and beyond the scope of this beginner’s guide. Feel free to
check them all out on the Formulas tab if you like to experiment.

Start With an Excel Template

One of the best ways to get started in Excel is to use a template. And you will find a large
variety of options both within Excel and on external sites.

Built-In Excel Templates

To view options within Excel, click File > New. You will then see a number of featured templates
you can use, categories you can pick from, and a search box if you want something specific.

New

New

[

Open

- Jo

Save Suggested searches:  Business Personal Industry  Financial Management Lists Logs Calculator

Sve As FEATURED  PERSONAL

Print "

TR DR

Export

- E - -
Shace FLOWCHARTS m .
= . g
N —

Publish

Close

Account

Project tracker Academic calendar (any year) Flowcharts Back to School Planner

Built-in templates range from simple calendars and planners to elaborate financial reports and
balance sheets. But there is a template for almost any common use that you would want in
Excel.

If you see a template you would like to view, click on it and then review its description and
download size in the pop-up window. If you want to use it, click the Create button.
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To-do list for projects

To-do list
m-— Provided by: Microsoft Corporation
Dute
_ Itemize each part of a project with this to-do list.
I This chart provides space for notes about each task
i : :"_ in the project and for percentage complete. This is
e an accessible template.
- T Download size: 19 KB
- [
- Pelaway ™

Create

Third-Party Excel Templates

If you would like to venture out and take a look at external templates, we have a variety of
suggestions for you depending on your need.

Once you get the hang of using Excel, you can also create your own templates to use again and

The Best Productivity Templates for Microsoft Excel to Get Things Done
10 Helpful Spreadsheet Templates To Help Manage Your Finances

10 More Spreadsheet Templates to Manage Your Money

Tips & Templates for Creating a Work Schedule in Excel

How to Make Your Project a Success with Excel Templates

Turn Excel Into a Tax Calculator With These Templates

again. From fundraising tools to helpful calendars, saving a spreadsheet you create as a
template is easier than you think.
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Are You Ready to Dig Into Excel?

Hopefully, this beginner’s guide will get you on your way to a great experience with Microsoft
Excel. There are many features and functions that can be intimidating to brand new users. But

those you see here should help you learn as you go when creating your first workbook full of
spreadsheets. If you have other tips for new users, let us know in the comment section!

Read more stories like this at
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